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The University of British Columbia Medical Journal (UBCMJ) is a student-run academic 
journal with a goal to engage students in dialogue in medicine. Our scope ranges from 
original research and review articles in medicine to medical trends, clinical reports, 
elective reports and commentaries in the principles and practice of medicine. We strive to 
maintain a high level of integrity and accuracy in our work, to encourage collaborative 
production and cross-disciplinary communication, and to stimulate critical and independent 
thinking.   

 
We have a goal of establishing ourselves as one of the leading student-run publications in 
Canada and internationally, and expect high quality from our submissions. We accept 
submissions in all areas of medicine, including but not limited to research, reviews, case 
reports, medical history, ethics, medical anthropology, epidemiology, public health, and 
international health.	
  	
  

Submission	
  Guidelines	
  

Articles are submitted online (http://ojs.library.ubc.ca/index.php/ubcmj) via our online submissions system, 
OJS. The author must create an account on our Online Submission System and "Start a New Submission".  
Please submit articles as Microsoft Word 97-2003 documents. If the authors are unsure of the suitability 
of their article for a particular section, please contact the appropriate Section Editor (see last page for 
"Correspondence").  

Author	
  Eligibility  
Authors must acknowledge and declare any sources of funding or potential conflicting interest, such as 
receiving funds or fees by, or holding stocks and benefited financially from, an organization that may profit 
or lose through publication of the submitted paper. Declaring a competing interest will not necessarily 
preclude publication but will be conducive to the UBCMJ’s goal of transparency. Such information will be 
held in confidence while the paper is under review and will not influence the editorial decision. If the 
article is accepted for publication, the editors will discuss with the authors the manner in which such 
information is to be communicated to the reader. UBCMJ expects that authors of accepted articles do not to 
have any financial ties to or interest in the makers of products discussed in the article.  

Formatting	
  Criteria	
  	
  

Formatting should conform strictly with the ICMJE Uniform Requirements for Manuscripts Submitted to 
Biomedical Journals (http://www.download.thelancet.com/flatcontentassets/authors/icmje.pdf), also known 
as the Vancouver Style. Manuscripts not conforming to the UBCMJ style will be returned with a request 
for revision. Manuscripts should be submitted as Microsoft Word 97-2003 documents and written in 
clear, grammatical English, with 12-point font and double-spaced formatting. Articles should be written in 
a manner that conveys professionalism and is appropriate for a journal suitable for the quality and calibre of 
our publication. Manuscript pages must be numbered consecutively with the title page constituting page 1. 
We expect authors to include continuous line numbers on their manuscripts (instructions below) and 
remove all identifying information from the manuscript (include from file information tags) prior to 
submission for review. 
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Add	
  line	
  numbers	
  to	
  an	
  entire	
  document 
1. On the Page Layout tab, in the Page Setup group, click Line Numbers.  

  

 Note   If your document is divided into sections and you want to add line numbers to the entire 
document, you first need to select the document. Click Select in the Editing group on the Home tab, 
and then click Select All. Or press CTRL+A.  

To number consecutively throughout the document, click Continuous.  

Remove	
  line	
  numbers 
You can remove line numbers from the entire document, from a section, or from a paragraph.  
1. Click in the document, or click in the section or paragraph from which you want to remove line 

numbers. If you want to remove line numbers from multiple sections, select the sections.  
2. On the Page Layout tab, in the Page Setup group, click Line Numbers.  

  

3. Do one of the following:  
1. To remove line numbers from the entire document or section, click None.  

2. To remove line numbers from a single paragraph, click Suppress for Current 
Paragraph.  

	
  	
  From:	
  http://office.microsoft.com/en-­‐us/word/HP012292791033.aspx	
  

	
  

All	
  articles	
  should	
  be	
  submitted	
  by	
  the	
  primary	
  author	
  and	
  should	
  contain	
  the	
  
following:	
   

Cover	
  Letter	
  	
  
 
A cover letter should be included in the online submission as a separate document to the manuscript 
indicating:  

 
1. that the paper is being submitted for consideration for publication in the UBCMJ;      

 
2. the address, email, and telephone for primary correspondence;  

 
3. that the manuscript submitted is an original work and that the identical document has not been, nor 

will be submitted to any other scientific or medical journal or avenue of publication with the 
exception of conference abstracts (please see the UBCMJ copyright policy);  
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4. that all of the authors are aware of, and agree to, the content of the manuscript and that 
authorization has been given in the form of a consent form to use any information conveyed by 
either personal communication or release of unpublished experimental data;  
 

5. the section to which the article is to be submitted (Academic Research, Reviews, Commentaries, 
Case and Elective Reports, Global Health) and up to 5 key words (MESH headings) describing the 
article; 
   

6. 1-3 recommendations for faculty or professional reviewers to expedite the review process. 
This is pivotal to our review process and authors must suggest a reviewer that will be able to 
critically appraise all aspects of the paper. (Please be aware that reviewers will sign a statement of 
disclosure indicating any potential conflicts of interest in reviewing the manuscript);  
 

7. Each author’s full name, relevant degrees obtained, professional/institutional affiliations, and if a 
medical student, medical school class and site (example: VFMP 2010).  
 

8. In OJS, covering letters should be included as an attachment under "Supplemental Files".   

Manuscript  
No author identifying information should appear in any place within the manuscript. Identifying 
information may compromise the double-blind peer review process. Author information appearing 
anywhere in the manuscript may cause the manuscript to be returned for further editing.  

Title	
  Page	
   
The title page should constitute the first page of the manuscript and include only the title of the manuscript.  
   
Abstract	
   
The abstract should provide a comprehensive, accessible summary of the material presented in the article 
and should avoid abbreviations.  All submissions require abstracts with the exception of News, Letters to 
the Editor, and Research Letters.  Please refer to the specific submission criteria below for abstract word 
limits.   
	
  
Organization	
   
The article should be clearly organized with an appropriate introduction, development, and conclusion. 
Longer articles should consider incorporating subheadings for more appropriate formatting.  

Tables, Figures,	
  and	
  Graphics  
Authors are responsible for obtaining permission to use any tables, illustrations, or figures adapted from 
other sources.  Tables may be included at the end of the manuscript with each table starting on a separate 
page or may be submitted as a separate file.  All tables must be accompanied by a table number as 
referenced in the text, title and caption, and should explain all abbreviations used.  No vertical lines may be 
used.  We accept the following file formats for tables:  

Adobe Acrobat PDF                
Microsoft Word (Word 97-2003 Document)  

Figures and graphics must be submitted as separate files and named according to its reference in the text 
(e.g., figure1.jpeg, figure2.gif, etc.). Figures should be digitally-rendered; freehand-drawn figures, scanned 
figures and direct SPSS output will not be accepted.  
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Figures should explain all abbreviations used.  Captions must be included at the end of the manuscript for 
each figure/graphic submitted with indications as to which image file it corresponds to.  We accept the 
following image formats:  

JPEG 300 dpi or higher, minimum compression  
GIF 300 dpi or higher (NOT accepted for photographs)  
TIFF (photos only, no text, minimum 300 dpi)  

 
Images must be grayscale or CMYK (no RGB). 
 
References 
Authors are responsible for the accuracy of references cited within the manuscript. References should 
follow the order in which they appear in the text. References must adhere to the Vancouver style.  In-text 
references should be indicated by numbering within parentheses placed AFTER punctuation marks where 
applicable (e.g., Diane Wu and Pam Verma, UBC medical students,(1) started the new UBCMJ in 
2009.(2)).  

Authors must provide all relevant information when submitting journal articles, including both the full 
name and abbreviated version of the journal title. Unpublished articles and informal communication should 
also be cited in concordance with the Vancouver style. Manuscripts are limited at 50 references and authors 
are encouraged to cite the most recent references where appropriate. Abstracts do not need to be referenced.  

Refer to the ICMJE guidelines (http://www.download.thelancet.com/flatcontentassets/authors/icmje.pdf) 
for more information on the Vancouver Style.  

Some examples:  

Piper P, Powell SS, and Peters J. Pickled Peppers. NEJM 2001 Feb 31;765(1):897-905.  

Piper, P. Pickled Peppers [Online]. 2008 Sept 7 [cited 2009 Jun 13]; Available from: 
http://www.peppers.com/peppers.html.  
	
  

Drug	
  Names	
  

Both generic and trade names should be provided for all drugs, with the generic name in lower-case and the 
commercial name in parentheses and with a first letter in upper case. Drugs not yet available in Canada 
should be so noted.  

Specific	
  Submission	
  Criteria  
Academic	
  Research	
   
Research articles report student-driven research projects and succinctly describe findings in a manner 
appropriate for a general medical audience. The articles should place findings within the context of current 
literature in their respective disciplines.  

Full Length Articles should not exceed 3000 words excluding abstract, figures, tables, and 
references. Accepted manuscripts may be shortened for the print edition of the UBCMJ with 
complete versions of the article appearing online. Research should be divided into the subheadings 
INTRODUCTION, MATERIALS AND METHODS, RESULTS, DISCUSSION, 
ACKNOWLEDGEMENTS (if any), REFERENCES, DISCLAIMERS (if any). Subheadings 
within sections are encouraged if they facilitate presentation of the material. Each full length 
article must include a structured abstract in the format of OBJECTIVE, METHODS, RESULTS, 
AND CONCLUSION not exceeding 250 words.  
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Research Letters summarize research of a shorter length and depth. These do not require 
extensive elaborations regarding methods or results. Research letters should not exceed 800 words 
with a maximum of 2 figures or tables. No abstract is required for research letters.  

Disclosure	
  Agreements 
If in your manuscript you acknowledge anyone for a contribution that goes beyond administrative 
assistance, you must obtain written permission from that person to publish his or her name. It is 
required that all co-authors and other contributors sign a disclosure agreement that accompanies 
the submission. It is expected that all authors have read and understood the UBCMJ Copyright 
Policy prior to submission.  

Case	
  and	
  Elective	
  Reports	
   
Case Reports describe notable clinical encounters with patients or in a public health setting. The case 
should provide a relevant teaching point for medical students. Each case report should include an abstract, 
an introduction to the case, a history of the presenting problem, relevant signs and symptoms, diagnostic 
tests, and a discussion of potential treatment possibilities before arriving at a definitive diagnosis. 
Following the diagnosis should be a brief review of the pathophysiology of the condition and aspects of its 
presentation and history. The abstract should not exceed 250 words and the article should not exceed 1500 
words (excluding the abstract).  
 
Patient consent  
Submissions must include acknowledgement from the patient in order to be considered for publication. A 
copy of the written consent obtained from the patient must accompany the submission. It is expected 
that the author has read and understood the UBCMJ’s consent policy prior to submission.  
 
SOAP note 
In addition to the standard submission criteria, case reports are encouraged to include a brief (200 word 
maximum) inset summarizing the findings in the form of a standard medical history SOAP note 
(Subjective, Objective, Assessment, Plan).  

Elective Reports aim to increase student exposure to a variety of medical specialties and training 
opportunities both locally and internationally. Reports give a specific description of the scope of practice of 
a medical specialty and/or training program, and recall the student’s impressions and reflections during and 
upon completion of the elective. They should highlight the student's clinical experiences and the unique 
features offered by the program. The abstract should not exceed 250 words and the article should not 
exceed 1000 words (excluding the abstract). Examples of Elective Reports can be found at the Lancet 
Student (http://www.thelancetstudent.com/category/electives/). 

Reviews  
The purpose of this section is to discuss academic literature and current biomedical research. Reviews 
provide an overview of a body of scientific work or a medical trend. Reviews may outline a current medical 
issue or give insight into the principles of practice of a clinical field. Authors may choose to review the 
etiology, diagnosis, treatment, or epidemiology of a specific disease. Articles may also provide a survey of 
literature dealing with philosophy or social sciences. Each article must include an abstract not exceeding 
250 words. The full length article should not exceed 1750 words (excluding abstract).   
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News	
  and	
  Letters	
  	
  
Abstracts are not required for News and Letters submissions.  There are three main types of submissions: 
 

1. News Articles highlight current events in the field of medicine as well as significant medical 
advancements.  Articles should not exceed 500 words.   
 

2. Feature Interview articles are meant to highlight the successful careers of different medical 
professionals who have contributed significantly to their field.  Advice for medical students 
interested in pursuing a career in the field should also be included.  Articles should not 
exceed 500 words.  

 
3. Letters to the Editor are meant for readers to express their opinion in response to any 

articles published in past issues of the UBCMJ.  Limit is 100-200 words.	
  
 

Commentaries 	
  
The aim of this section is to provide a platform for intellectual dialogue on topics relevant to the study and 
practice of medicine. Articles submitted to this section should correspond to one of the following 
descriptions outlined below.  A 75-100 word abstract is required; this is not included in the word counts 
described below:   

1. Subjective pieces relevant to medical studies, life as a future physician, or the current social 
context  of medicine. Commentaries may draw on personal experiences to convey the 
writer's perspective. Articles should not exceed 1000 words.  
 

2. An article that highlights the significance of an interesting research study or area from a 
clinical perspective. If focusing on an article, the author should summarize the research 
methodology and findings, critically evaluate the experimental design, suggest future 
experiments, and discuss current research trends in that field. Articles should not exceed 
1000 words. 	
  

	
  
3. Book Reports are brief reports that feature a non-fiction or fiction work and explain its 

significance and context in the practice and study of medicine. Book reports should highlight 
key viewpoints and facts presented in the book in an objective fashion, and explain the 
relevance of the book to the principles of medical practice.  The manuscript should include 
in its heading the book name, author, year of publication, number of pages, and printing 
house. Articles should not exceed 800 words. 	
  
	
  

Global	
  Health	
  
Abstracts not exceeding 75-100 words are required for this section.  Abstracts are not included in the word 
counts listed below. 
 
This section deals with specific experiences or issues in global health; these generally fit into the WHO 
definition of global health as "the health of populations in a global context that transcends the perspectives 
and concerns of individual nations." Articles should reflect on current or historical issues of international 
relevance. Articles submitted to this section should correspond to one of the following formats: 
	
  

1. Editorials are well-researched submission that outline a current or historical global health 
issue or expose and explore aspects of global health subject that can relate to such topics as 
ethics, principles, practice, and new developments in global health. Articles should not 
exceed 1200 words. 
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2. Commentaries are subjective, anecdotal pieces of personal reflection upon a global health 
related issue; they draw on personal experiences and convey the writer's perspective. 
Articles should not exceed 1000 words. 

 
3. Dispatches are brief articles that offer a perspective on a specific global health experience. 

They can range from a straightforward description of what occurred to a more artistic point 
of view on an experience, such as using it as a metaphor for other issues, linking the 
experience to arts and humanities, or any other unique analysis of global health experience. 
Articles in this section should not exceed 300 words. 

Review	
  Process  

Submissions will be initially reviewed by the Editors in Chief, Managing Editors, and relevant Section 
Editors as part of an initial screening process. Those articles selected for further review will be sent as 
anonymous manuscripts to reviewers: one faculty member, clinician, or professional expert and one or two 
medical students, all of whom will have experience or expertise in the field of the submission. The results 
of the review process will then be reviewed by the Section Editors, who will make a decision as to 
recommending the manuscript for publication. The editors reserve the right to edit manuscripts, overrule 
the decision of a peer reviewer, fit articles into available space, or suggest further changes to ensure 
conciseness, clarity, and consistency of the journal. Articles may be accepted for publication, accepted with 
revisions, or rejected for the current issue.  

Authors will be required to authorize publication of the manuscript in its final format prior to its appearance 
in the journal. Should an article be returned for revisions, authors will have two weeks upon return of the 
paper to make the necessary changes and return the corrected paper to the corresponding Section Editor. 
Revised copies of the manuscripts should be uploaded onto the OJS under "Editor Decision". Should a 
paper be rejected, the authors will be notified as to the decision and be encouraged to re-submit after 
considering and responding to all the reviewers' comments and making corresponding changes in the 
revised manuscript. The re-submitted manuscript will be considered a new submission and will be subject 
to the standard review process of the UBCMJ.  

Deadlines	
   
The UBCMJ works on a very tight review and production schedule. Due to the large number of 
submissions expected, and in order to expedite the review process, it is strongly suggested that authors 
submit their manuscript as early as possible prior to the submissions deadline. Earlier submissions are more 
likely to undergo review for the intended edition. Articles that cannot be reviewed for the current issue due 
to volume will be reviewed in the next cycle of submissions with priority status.  

   

 

 

 

 

** Please note that views expressed in this journal do not necessarily reflect the views of the editors 
or the Faculty of Medicine or any organizations affiliated with this publication. They are solely the 
authors’ opinion and are intended to stimulate academic dialogue.  
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Correspondence  
For any questions related to your submission, please contact the appropriate Section Editors.  
Thank you. 
 
Academic Research (academic@ubcmj.com) 

Case and Elective Reports (reports@ubcmj.com) 

Reviews (reviews@ubcmj.com) 

News and Letters (news@ubcmj.com) 

Global Health (global.health@ubcmj.com) 

Commentaries (commentaries@ubcmj.com) 

 

©	
  UBC	
  Medical	
  Journal	
  2010. 

	
    


